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Legal Information
Copyright ©1994 - 2009 Sonic Solutions. All Rights reserved. Unauthorized reproduction or 
distribution of this program, or any portion of it, may result in severe civil and criminal penalties, 
and will be prosecuted to the maximum extent possible under law. Use of these products is 
subject to the acceptance of the license agreement included in this product.

Sonic, Sonic Solutions, Roxio, Roxio Creator, PhotoSuite, VideoWave, MyDVD, Creator Classic, 
CinePlayer, CineMagic, Music Disc Creator, Automix, Video Copy & Convert, Venue, 
CinemaNow, Qflix, and PhotoShow are trademarks owned by Sonic Solutions in the United 
States and/or other jurisdictions. All other trademarks used are owned by their respective owners.

SOME OR ALL OF THE FOLLOWING APPLY TO THIS PRODUCT:

Portions of the software are provided by Apple Computer, Inc. Copyright © 2004 Apple 
Computer, Inc.

iPod, iPod Touch, iTunes and iPhone are trademarks of Apple, Inc.

MPEG Layer-3 and mp3PRO audio coding technology licensed from Coding Technologies, 
Fraunhofer IIS and THOMSON.

http://www.iis.fhg.de/amm 

Portions utilize Microsoft Windows Media Technologies. Copyright © 1999-2009 Microsoft 
Corporation. All Rights Reserved. Windows Media, Zune, the Zune logo, Xbox, the Xbox logo, 
the Windows logo, and the Windows 7 logo are trademarks or registered trademarks of Microsoft 
Corporation in the United States and/or other countries. 

VST Plug-in Technology by Steinberg Copyright © 2004 Steinberg Media Technologies AG. 
Steinberg is a registered trademark of Steinberg Soft- und Hardware GmbH. 

Blu-ray is a trademark of the Blu-ray Disc Association.

YouTube and the Powered by YouTube logo are trademarks of Google Inc.

CUDA is a trademark of NVIDIA Corporation.
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AVCHD and the AVCHD Logo are trademarks of Panasonic Corporation and Sony Corporation, 
and are used under license.

ATI is a trademark of Advanced Micro Devices, Inc.

Some digital content © 1994-2001 Hemera* Technologies Inc. All Rights Reserved. * Trademark 
of Hemera Technologies Inc.

Ogg Vorbis audio compression technology provided courtesy of the Xiph.Org Foundation.

libfishsound 

----------------------- 

Copyright (C) 2003, 2004 Commonwealth Scientific and Industrial Research Organisation 
(CSIRO) Australia 

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS 
“AS IS” AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED 
TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE ORGANISATION 
OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, 
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,  
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR 
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF 
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING  
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS 
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

------------------------------------------------ 

libvorbis and libogg 

------------------------------------------------ 
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Copyright (c) 1994-2004 Xiph.org Foundation 

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS 
“AS IS” AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED 
TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE REGENTS OR 
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, 
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, 
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR 
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF 
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING 
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS 
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

------------------------------------------------------------- 

libflac and libflac++ 

----------------------------------------- 

Copyright (C) 2000,2001,2002,2003,2004 Josh Coalson 

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS 
``AS IS'' AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED 
TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE FOUNDATION OR 
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, 
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, 
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR 
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF 
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING 
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS 
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

-------------------------------------------------------- 

dsfOggDemux, dsfOggMux, dsfVorbisDecoder, dsfVorbisEncoder.dll, dsfNativeFLACSource, 
dsfFLACDecoder, dsfFLACEncoder, libOOOgg, libOOOggSeek 

------------------------------------ 

Copyright (C) 2003-2005 Zentaro Kavanagh 

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS 
“AS IS” AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED 
TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE ORGANISATION 
OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, 
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, 
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR 
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF 
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING 
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS 
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
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Audio effect engine licensed by Algorithmix. http://www.algorithmix.com

'Dolby' and the double-D symbol are trademarks of Dolby laboratories.

This product contains one or more programs protected under international and U.S. copyright 
laws as unpublished works. They are confidential and proprietary to Dolby Laboratories. Their 
reproduction or disclosure, in whole or in part, or the production of derivative works therefrom 
without the express permission of Dolby Laboratories is prohibited. Copyright 1992-2009 by 
Dolby Laboratories, Inc. 

Manufactured under license from Dolby Laboratories.

The TWAIN Toolkit is distributed as is. The developer and distributors of the TWAIN Toolkit 
expressly disclaim all implied, express or statutory warranties including, without limitation, the 
implied warranties of merchantability, non-infringement of third party rights and fitness for a 
particular purpose. Neither the developers nor the distributors will be liable for damages, 
whether direct, indirect, special, incidental, or consequential, as a result of the reproduction, 
modification, distribution or other use of the TWAIN Toolkit.
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Music recognition technology and related data are provided by Gracenote, Inc. Gracenote is the 
industry standard in music recognition technology and related content delivery.  For more 
information, visit www.gracenote.com.

CD and music-related data from Gracenote, Inc., copyright © 2000-2008 Gracenote. Gracenote 
Software, copyright © 2000-2008 Gracenote. One or more patents owned by Gracenote apply to 
this product and service.  See the Gracenote website for a non-exhaustive list of applicable 
Gracenote patents.  Gracenote, CDDB, MusicID, the Gracenote logo and logotype, and the 
"Powered by Gracenote" logo are either registered trademarks or trademarks of Gracenote in the 
United States and/or other countries.

Gracenote®, Gracenote logo and logotype, and the "Powered by Gracenote" logo are either 
registered trademarks or trademarks of Gracenote, Inc. in the United States and/or other 
countries.

For more information on using the Gracenote Service, visit: www.gracenote.com/corporate.

Portions Copyright 1997, Chris Losinger 

Portions of this product were created using LEADTOOLS © 1991-2001, LEAD Technologies, Inc. 
ALL RIGHTS RESERVED.

Product includes the 3ivx Filter Suite. Copyright © 3ivx Technologies Pty. Ltd., 1999-2003, All 
rights reserved. 3ivx is an international trademark.

Some digital content provided by Digital Vision.

Certain templates and images: © 2004 ArtBuilders.

Some audio content provided by Darklab Sound.

Some audio content is provided by Todor Kobakov from spineproductions.net.

Some content courtesy of Artbeats. www.artbeats.com

Some digital image content © 2006 Jupiterimages Corporation. All Rights Reserved.
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Some audio content © 2006 Ian Nieman Music. All rights reserved.

Portions Copyright 1997-1998 Intel Corporation. 

This product uses the LAME MP3 Encoder library (the “Library”).  The Library is licensed under 
the GNU Library General Public License, Version 2, 1991.  For a copy of the complete 
corresponding machine-readable source code for the Library, send your request to Sonic 
Solutions, 101 Rowland, Suite 110, Novato, CA 94945 Attn: Legal Department.  Processing, 
shipping, and handling charges will apply.

FFmpeg is a trademark of Fabrice Bellard, originator of the FFmpeg project.

This product uses the libavcodec library (the “Library”).  The Library is licensed under the GNU 
Lesser General Public License, Version 2.1.  For a copy of the complete corresponding machine-
readable source code for the Library, send your request to Sonic Solutions, 101 Rowland, Suite 
110, Novato, CA 94945 Attn: Legal Department.  Processing, shipping, and handling charges will 
apply.

THIS PRODUCT IS LICENSED UNDER THE MPEG-4 VISUAL PATENT PORTFOLIO 
LICENSE FOR THE PERSONAL AND NON-COMMERCIAL USE OF A CONSUMER FOR (i) 
ENCODING VIDEO IN COMPLIANCE WITH THE MPEG-4 VISUAL STANDARD (“MPEG-4 
VIDEO”) AND/OR (ii) DECODING MPEG-4 VIDEO THAT WAS ENCODED BY A 
CONSUMER ENGAGED IN A PERSONAL AND NONCOMMERCIAL ACTIVITY AND/OR 
WAS OBTAINED FROM A VIDEO PROVIDER LICENSED BY MPEG LA TO PROVIDE 
MPEG-4 VIDEO. NO LICENSE IS GRANTED OR SHALL BE IMPLIED FOR ANY OTHER 
USE. ADDITIONAL INFORMATION INCLUDING THAT RELATING TO PROMOTIONAL, 
INTERNAL AND COMMERCIAL USES AND LICENSING MAY BE OBTAINED FROM MPEG 
LA, LLC. SEE HTTP://WWW.MPEGLA.COM.

PSP is a registered trademark of Sony Computer Entertainment, and Memory Stick is a 
trademark of Sony Corporation.

The Bluetooth® word mark and logos are owned by the Bluetooth SIG, Inc., and any use of such 
marks by Sonic Solutions is under license. Other trademarks and trade names are those of their 
respective owners.

Wii is a registered trademark of Nintendo.

Blackberry is a registered trademark of Research in Motion Limited.

TiVo and the TiVo logo are registered trademarks of TiVo Inc. or its subsidiaries.
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This product is protected by certain intellectual property rights of Microsoft Corporation. Use or 
distribution of such technology outside of this product is prohibited without a license from 
Microsoft or an authorized Microsoft subsidiary.

Windows Pre-Installation Environment. Disaster recovery applications included in this product 
may use the Microsoft® Windows® Preinstallation Environment software from Microsoft 
Corporation (“WinPE”). The WinPE softare included with this software may be used for boot, 
diagnostic, setup, restoration, installation, configuration, test or disaster recovery purposes only.  
NOTE: THIS SOFTWARE CONTAINS A SECURITY FEATURE THAT WILL CAUSE YOUR 
COMPUTER SYSTEM TO REBOOT WITHOUT PRIOR NOTIFICATION TO YOU AFTER 24 
HOURS OF CONTINUOUS USE. WinPE may not be used as a general purpose operating system 
or as a substitute for a fully functional version of any operating system product. Use of WinPE is 
“as-is”.

Changes
The material in this document is for information purposes only and is subject to change without 
notice. While reasonable efforts have been made in the preparation of this document to assure its 
accuracy, Sonic Solutions assumes no liability resulting from errors or omissions in this 
document, nor from the use of the information contained herein.

Sonic Solutions reserves the right to make changes in the product design without reservation and 
without notification to its users.

Disclaimer
This product may allow you to reproduce materials in which you own the copyright or have 
obtained permission to copy from the copyright owner. Unless you own the copyright or have 
permission to copy such materials from the copyright owner, you may be violating copyright law 
and be subject to the payment of damages and other remedies. If you are uncertain of your rights, 
you should contact your legal advisor.

This product may be protected by one or more of the patents listed at 
http://www.sonic.com/innovation/patents.



9

C12_GettingStartedGuide.book  Page 9  Tuesday, June 30, 2009  10:16 AM
Getting started
with Roxio Creator
In this guide

Welcome to Roxio Creator 10

About this guide 10

Installing Creator 11

Getting to know Creator 12

Creator: What you can do 13

Completing a typical task 17

Where to find more information 21

Creator support options 22



Roxio Creator Getting Started Guide
www.roxio.com10

C12_GettingStartedGuide.book  Page 10  Tuesday, June 30, 2009  10:16 AM
Welcome to Roxio Creator
Welcome to Roxio Creator, the all-in-one digital media solution. 

Designed for beginners and experts alike, Creator makes it all easy—from 
simple and practical tasks, such as creating a backup copy of a disc, to fun 
and creative projects such as creating a home movie complete with 
introductions, transitions, music, and effects. 

Get creative and have fun with this powerful, intuitive, and easy-to-use 
suite of digital media components. Do more with your digital music, 
favorite photos, mobile phone, cherished video, and your important data 
files. Find all the tools you need in one place, with one easy-to-use interface. 

About this guide
This guide provides an overview of Creator to help you get started. For 
detailed information about how to use all of the features of Creator, see the 
online Help described in Where to find more information on page 21.

Depending on the version of Creator you are using, some of the 
components described in this guide may not be available.
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Installing Creator
Follow this procedure to install Creator. 

To install Creator using the installation disc: 

1 Insert the Creator installation DVD into your DVD drive.

If Autorun is enabled on your computer, the Creator installation 
window appears automatically and you can skip step 2 and step 3.

2 Choose Start > Run.

3 Type d:\setup (substitute the appropriate letter of your DVD drive 
for d).

4 Follow the installation instructions that appear on the screen.

To install Creator using downloaded files:

1 Navigate to the Creator install package.

2 Double-click the setup.exe file.

3 Follow the on-screen instructions.
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Getting to know Creator
Start your digital media projects from Creator’s main window. Double-click 
the Creator desktop icon to begin.

Creator’s main window, featuring the project category tabs and links 
to frequent tasks.

Starting a task
Click one of the project category tabs on the left side of the window, and a 
task list appears on the right. Choose a task by clicking on its name. Some of 
the tasks are built into the main Creator window; others open in a separate 
window.
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Creator: What you can do
There are so many great things you can do with Creator. Here’s a partial list 
and how to get started:

Working with audio
You will find links to these tasks by selecting the Music-Audio project tab:

■ Make an audio CD that you can play anywhere. Select the Burn Audio 
CDs task.

■ Create an MP3 disc that holds hundreds of songs in MP3, WMA, or 
WAV format. Select the Burn MP3 CDs task.

■ Rip audio files from a CD to your computer. Select the Rip task. (To 
rip songs from more than one drive at a time, select Rip - Advanced.)

■ Quickly capture (record) audio from Internet radio and other 
sources using your computer’s sound card. Select the 
Capture Audio from Sound Card task.

■ Record and edit sound clips and audio files to create your own 
audio mixes. Select the Edit Audio task.

■ Create music compilations to play on your home or car stereo, 
portable music player, DVD player, or on your computer. Use the 
Beat Matching feature to create mixes your friends will envy. Select the 
Create Music Disc Projects task.

■ Transfer audiobooks from audio CDs or the Internet to an iPod®, 
iPhone, or other portable device with just a few clicks. Select the 
Create Audiobooks task.

■ Create a DVD Music Disc with up to 50 hours of music using tracks 
from your computer or from any number of audio discs. Choose from 
professionally designed menu styles or use your own background 
image, then burn your project to a disc and play on it your computer 
or set-top player. Select the Create DVD Music Discs task.

■ Create digital audio files from your old LPs and tapes in just a few 
simple steps. You can then clean and enhance your audio files, burn 
them to an audio CD, or use them in your Creator projects. Select the 
Digitize LPs and Tapes task.
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Working with photos
You will find links to these tasks by selecting the Photo project tab:

■ Create multimedia slideshows and post them online for your 
friends to see. (English only.) Select the Create PhotoShows task.

■ Enhance, edit, and share your digital photos. Automatically adjust 
the exposure, saturation, and sharpness of photos. Fix common 
problems such as red eye. Select the Edit Photos task.

■ Create personalized calendars, greeting cards, and collages 
using your own photos. You can also create photo slideshows to share 
with others. Select the Create Projects task.

■ Enhance several photos at once using AutoFix and other photo 
tools. Rename or convert groups of photos to a different format. Select 
the Enhance Multiple Photos task.

■ Create a dramatic panorama by combining several photos into one. 
Select the Create Panoramas task.

■ E-mail your photos and photo projects to friends and family. Select 
the Email task.

■ Create a high-resolution photo slideshow in just a few clicks, 
including background audio and Pan and Zoom effects. Select the 
Create Slideshows task.

Working with video
You will find links to these tasks by selecting the Video-Movies project tab:

■ Convert video to the perfect format for your portable media 
player, and make copies of personal DVD discs so you can store the 
originals for safekeeping. Select the Copy and Convert Video task.

■ Watch movies using the ultimate digital theater. Creator delivers the 
absolute highest quality video playback available for your PC and 
packs all of its powerful features into an extremely easy-to-use and 
intuitive user-interface. Select the Play Movies task.

■ Post videos on YouTube. It doesn’t get any easier than this. Select the 
Share Video task.
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■ Create professional-looking video productions that combine your 
home videos and photos with audio, transitions, and special effects. 
Select the Edit Video—Advanced task.

■ Make great looking video productions in a few easy steps. Select 
the Create DVDs task.

■ Create more elaborate multimedia stories on DVD to share with 
family and friends. Capture and mix photos and video, include 
narration or a favorite sound track, create your own professional-
looking menus, add transitions and animated backgrounds, and burn 
to DVD, Video CD, or Super VCD. Some versions even let you author 
Blu-ray movie discs. Select the Create DVDs—Advanced task.

■ Copy video directly from a camcorder to a disc. Select the Plug 
and Burn task.

■ Transfer video footage from your AVCHD camera onto a DVD or 
Blu-ray Disc for safekeeping. Your movies are stored exactly as they 
were shot, in full high-definition. Select the Archive AVCHD task.

Data and copy projects
You will find links to these tasks by selecting the Data-Copy project tab:

■ Copy files to a CD, DVD, or Blu-ray Disc. Select the Burn Data 
Disc task.

■ Duplicate an entire disc. Select the Copy Disc task.

■ Create encrypted data CDs and DVDs, and archive large projects to 
multiple discs. Create advanced format and bootable discs, and more. 
Select the Burn Data Disc—Advanced task.

■ Back up the files on your computer to a wide range of storage 
devices including discs, external hard drives, and flash drives. 
Select the Backup and Restore task.

Note  The Backup and Restore task is not available in all versions 
of Roxio Creator.
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Importing and organizing media files
You may find links to these tasks on more than one project tab:

■ Import photos and video files to your computer from your digital 
camera, mobile phone, or camcorder. Select the 
Import Photos or Capture Video tasks.

■ View and manage your media files in folders, and to organize them 
into personalized albums. Find files quickly by browsing or searching, 
and burn your files to a disc. Select the Browse and Manage Media task.

■ Transfer files to your wireless devices, and upload video files to the 
Internet. Select the Browse and Manage Media task.

Creating labels and disc inserts
You will find links to this task on all of the project tabs:

■ Make personalized disc labels and jewel case covers using a 
simple task assistant. Choose from dozens of professional designs, or 
create your own. Select the Create Labels task.

■ Make personalized disc labels and jewel case covers using our 
full-featured label-making application. Choose from dozens of 
professional designs, or create your own. Select the 
Create Labels—Advanced task.

Don’t forget the Tools menu
■ Erase or finalize a disc, get disc information, and keep track of 

what’s on your discs. All of these tasks can be started from the Tools 
menu. This is also where you’ll go to create virtual disc drives.
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Completing a typical task
Each task in Creator is a little different. Some are incredibly simple. Others 
take a little time to master. To help you get started, let’s walk though one of 
the most useful projects—creating a disc that contains files copied from 
your computer.

1 Open Creator by double-clicking the icon that was placed on your 
computer desktop during installation. In most cases, the main Creator 
application window opens with the Home category selected. It will 
look something like this:

The Home window includes links to frequently used tasks.

On the left side of the window, you will see the names of several 
project categories. Since we are going to be making a data disc, click 
the Data-Copy category.

The application window changes and displays a set of tasks that are 
related to protecting or copying the valuable files stored on your 
computer.



Roxio Creator Getting Started Guide
www.roxio.com18

C12_GettingStartedGuide.book  Page 18  Tuesday, June 30, 2009  10:16 AM
2 When you are ready, click Burn Data Disc.

In the illustration above, a link for the Burn Data Disc project 
appears in the suggested projects area near the top of the window 
and again in the Create section.

The application window changes again. It now displays everything you 
need to set up your project and burn a disc. 

Burn Data Disc project window with files added.

As you can see, the Burn Data Disc project is built into the main 
Creator application window. Some projects are built into the main 
window; others open in a separate window. Many components that 
open in separate windows have names you may know: MyDVD, 
VideoWave, CinePlayer. They are all part of your Creator suite.

3 To begin a data disc project, insert a blank CD, DVD, or Blu-ray Disc 
into your computer’s disc drive. (The project also allows you to add 
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files to an existing data disc, but to keep things simple for this project, 
use a blank disc.)

4 Use the Destination drop-down menu to select the drive holding your 
blank disc. If your computer only has one disc drive, it will be selected 
automatically.

Click the Destination menu and choose from the list of available 
drives.

5 Now you are going to add files to the project.

Click the Add button located near the top of the Burn Data Disc 
project window. Choose Files or Folder from the submenu.

A dialog window opens. Use it to select the files or folders you would 
like to add.

Use the toolbars to open the Quick Scan panel, add files, open 
saved projects, and delete files from a project.

6 Near the Add button on the project window toolbar is the Name Your 
Disc text box. Enter a name for your disc, so it will be easy to recognize 
the next time you use it.

While you are using the project toolbars, notice that they include some 
other useful features:

■ The retractable Quick Scan panel makes it easy to select files by 

category. 

■ To the right of the Add button is the Projects button that you can 

use to easily find saved projects. 
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■ Next to that is the Make Bootable button. Use it to create a 

bootable disc that can be used to start your computer if 

something should ever go wrong with the Windows operating 

system.

Before burning your data disc, look along the bottom of the project 
window. Here you will find several project status indicators. The 
information presented varies from project to project and is updated 
when you change discs or destination drives.

Project information is displayed along the bottom of the window.

In this case, the indicator shows the project size, the type of disc in the 
drive, and the available disc space.

7 Now you are ready to burn a disc. To begin, click the large green Go 
button on the bottom right corner of the project window. A progress 
indicator appears, and your files are copied onto the disc.

The progress indicator shows a burn in progress.

You don’t have to wait for this project to finish before starting one of 
the other projects in Roxio Creator. But you can only have one project 
of each type running at a time.

When the project is finished, remove your disc and click Finish. If you 
would like to save this project so the same file set can be easily burned 
in the future, click the File menu and select Save.
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Where to find more information
This guide provides an overview of Creator to help you get started. For 
detailed information about how to use all of the features of Creator, see the 
options described below.

Help
Most Creator components have an extensive, searchable Help Center. Each 
Help Center includes step-by-step procedures and answers to frequently 
asked questions. 

To access the Help Center, choose Help > Component Help Center. To 
view context-sensitive Help for your current activity, press F1.

Learning Center
Click the Learning Center tab to view tutorials to help you quickly become 
familiar with many of Creator’s key features. You can also access the Roxio 
KnowledgeBase, product information and more.

Roxio online support
If you can’t find the answers you are looking for in the Help or in this guide, 
you can get the most current information from our Web site. Launch your 
browser and go to http://support.roxio.com.
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Creator support options

Unlimited self-help options
Roxio provides a variety of self-help tools, a searchable knowledge base of 
support articles with troubleshooting tips, and tutorials that can help you 
get the most out of your Roxio products. 

Be sure to visit the Roxio Support Web site before you contact us by phone 
or e-mail—you’ll find answers to most of your questions at 
http://support.roxio.com.

Alternate support options
Alternate support options such as e-mail or telephone support may be 
available on a limited or paid basis for your Roxio product. Please visit our 
Web site at http://support.roxio.com to find out what options are available 
for your product.

Contacting Roxio
Log in to our Customer Web portal to submit a request for assistance or to 
find support contact information for your location. You can find the 
customer Web portal at http://selfserve.roxio.com.
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